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Foreword
This user’s manual contains useful information about the functions and operating 
procedures of the DataBrowser and lists the handling precautions of the software. To 
ensure correct use, please read this manual thoroughly before beginning operation.
After reading this manual, keep it in a convenient location for quick reference in the event 
a question arises during operation. 

Notes
•	 License numbers will not be reissued. Please keep your license numbers in a 

safe place. 
•	 The contents of this manual are subject to change without prior notice as a result 

of continuing improvements to the software’s performance and functions. Display 
contents illustrated in this manual may differ slightly from what actually appears on 
your screen.

•	 Every effort has been made in the preparation of this manual to ensure the accuracy 
of its contents. However, should you have any questions or find any errors, please 
contact your nearest YOKOGAWA representative, dealer, or sales office.

•	 This user’s manual does not cover the handling and operating procedures of 
Windows.

•	 Copying or reproducing all or any part of the contents of this manual without 
YOKOGAWA’s permission is strictly prohibited.

Trademarks
•	 DAQWORX, DAQLOGGER, and DAQEXPLORER are registered trademarks or 

trademarks of Yokogawa Electric Corporation.
•	 Microsoft and Windows are registered trademarks or trademarks of Microsoft 

Corporation in the United States and/or other countries.
•	 Adobe and Acrobat are registered trademarks or trademarks of Adobe Systems 

Incorporated.
•	 Company and product names that appear in this manual are registered trademarks or 

trademarks of their respective holders.
•	 The company and product names used in this manual are not accompanied by the 

registered trademark or trademark symbols (® and ™).

Revisions
•	 1st Edition		 February 2005
•	 2nd Edition		 June 2007
•	 3rd Edition		 January 2009

3rd Edition : January 2009 (YK)
All Rights Reserved, Copyright © 2005 Yokogawa Electric Corporation
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Terms and Conditions of the Software License

NOTICE - PLEASE READ CAREFULLY BEFORE USE
Thank you very much for purchasing this medium containing a software program and related documentation provided by Yokogawa Electric Corporation (hereinafter called 
“Yokogawa”), and the program contained, embedded, inserted or used in the medium (hereinafter called the “Yokogawa Software Program”).
By installing the Yokogawa Software Program, you acknowledge that you understand and fully agree to the “Terms and Conditions of the Software License” (hereinafter called 
“Terms and Conditions”) which is written in the documentation and separately attached. Accordingly, the Terms and Conditions bind you.
The Yokogawa Software Program and its related documentation including ownership of copyright shall remain the exclusive property of Yokogawa or those third parties who 
grants Yokogawa the rights.
Yokogawa hereby grants you permission to use the Yokogawa Software Program on the conditions that you agree to the Terms and Conditions before you install it in or onto 
a computer.

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS, YOU CANNOT INSTALL THIS MEDIUM, AND MUST PROMPTLY RETURN IT TO YOKOGAWA OR ITS 
DESIGNATED PARTY.

Terms and Conditions of the Software License
Yokogawa Electric Corporation, a Japanese corporation (hereinafter called “Yokogawa”), grants permission to use this Yokogawa Software Program (hereinafter called the 
“Licensed Software”) to you on the conditions that you agrees to the terms and conditions stipulated in Article 1 hereof.
You, as the Licensee (hereinafter called “Licensee”), shall agree to the following terms and conditions on the software license (hereinafter called the “Agreement”) when the 
Licensed Software is installed by the Licensee.
Please note that Yokogawa grants the Licensee permission to use the Licensed Software under the terms and conditions herein and in no event shall Yokogawa intend to 
sell or transfer the Licensed Software to the Licensee.

Article 1 (Licensed Software under these Terms and Conditions)
1.1	 The terms and conditions stipulated herein shall bind any Licensee who purchases the Licensed Software on the condition that the Licensee consents to agree to the 

terms and conditions stipulated herein.
1.2	 The “Licensed Software” and required number of license herein shall be specified in the following paragraphs (1) and (2) respectively. The Licensed Software means 

and includes all applicable programs and documentation, without limitation, all proprietary technology, algorithms, a factor, invariant, process and/or other know-how 
contained therein. These terms and conditions shall also govern any additional software to the Licensed Software inclusive of its version-up or revision-up if Yokogawa 
provides them to the Licensee.
(1)	 Licensed Software Name: Data Acquisition Software Suite DAQWORX
(2)	 Number of License: Same number as those media for the Licensed Software shall be acquired for installation.

Article 2 (Grant of License)
2.1	 Yokogawa grants the Licensee, for the purpose of single use, non-exclusive and non-transferable license of the Licensed Software with the license fee separately agreed 

upon by both parties.
2.2	 The Licensee is, unless otherwise agreed upon in writing by Yokogawa, not entitled to change, sell, distribute, transfer, or sublicense the Licensed Software.
2.3	 The Licensed Software shall not be copied in part or in whole except for keeping one (1) copy for back-up purpose. The Licensee shall secure or supervise the copy of 

the Licensed Software by the Licensee itself with great, strict, and due care.
2.4	 The Licensed Software remains the exclusive property of Yokogawa and, if any, those of third parties from whom Yokogawa is sublicensed (hereinafter such third party’s 

software is called “Third Party Software”, which may include any software program made or coded by affiliates of Yokogawa). In no event shall the Licensee dump, 
reverse assemble, reverse compile, or reverse engineer the Licensed Software so that the Licensee may translate the Licensed Software into other programs or change 
it into a man-readable form from the source code of the Licensed Software. Unless otherwise separately agreed upon by Yokogawa, Yokogawa shall not provide the 
Licensee the source code for the Licensed Software.

2.5	 The Licensed Software and its related documentation inclusive of its ownership of copyright shall be the proprietary property of Yokogawa or a third party who grants 
Yokogawa the rights. In no event shall the Licensee transfer, lease, sublicense, or assign any rights relating to the Licensed Software.

2.6	 Yokogawa may use or add copy protection in or onto the Licensed Software. In no event shall, regardless of the purpose, the Licensee remove or attempt to remove 
such copy protection.

2.7	 The Licensed Software may include the Third Party Software. In the case that Yokogawa is granted permission to sublicense to third parties by any licensors (sub-
licensor) of the Third Party Software under different terms and conditions than those stipulated in this  Agreement, the Licensee shall observe such terms and conditions 
of which Yokogawa notifies the Licensee in writing separately.

2.8	 In no event shall the Licensee modify, remove or delete a copyright notice of Yokogawa and its licenser contained in the Licensed Software, including any copy 
thereof.

Article 3 (Restriction of Specific Use)
3.1	 The Licensed Software shall not be intended specifically to be designed, developed, constructed, manufactured, distributed or maintained for the purpose of the following 

events:
a)	 Operation of any aviation, vessel, or support of those operations from the ground;
b)	 Operation of nuclear products, its facilities and/or radiation apparatus;,
c) 	 Operation of nuclear weapons, chemical weapons and/or biological weapons, or railroad; or
d)	 Operation of medical instrumentation directly utilized for humankind or the human body.

3.2	 Even if the Licensee uses the Licensed Software for the purposes in the preceding Paragraph 3.1, Yokogawa has no liability to or responsibility for any claims or 
damages arising out of the use or operations of the Licensed Software, and the Licensee agrees, on its own responsibility, to solve and settle the claims and damages 
and to defend, indemnify or hold Yokogawa totally harmless, from or against any liabilities, losses, damages and expenses (including fees for recalling the Products and 
reasonable attorney’s fees and court costs), or claims arising out of and related to the above-said claims and damages.

Article 4 (Warranty)
4.1	 The Licensee shall agree that the Licensed Software shall be provided to the Licensee on an “as is” basis when delivered. If defect(s), such as damage to the medium of 

the Licensed Software, attributable to Yokogawa is found, Yokogawa agrees to replace, free of charge, any Licensed Software on condition that the defective Licensed 
Software shall be returned to Yokogawa’s specified authorized service facility within  12 month from the delivery of Yokogawa after opening the Package at the Licensee’s 
expense. As the Licensed Software is provided to the Licensee on an “as is” basis when delivered, in no event shall Yokogawa warrant that any information on or in the 
Licensed Software, including without limitation, data on computer programs and program listings, be completely accurate, correct, reliable, or the most updated.

4.2	 Notwithstanding the preceding Paragraph 4.1, when Third Party Software is included in the Licensed Software, the warranty period and related conditions that apply 
shall be those established by the provider of the third party software.
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4.3	 When Yokogawa decides in its own judgement that it is necessary, Yokogawa may from time to time provide the Licensee with Release Upgrades specified by Yokogawa 
(hereinafter called “Release Upgrades”).

4.4	 Notwithstanding the preceding Paragraph 4.3, in no event shall Yokogawa provide Updates where the Licensee or any third party conducted renovation or improvement 
of the Licensed Software.

4.5	 Correction of nonconformity in the manner and for the period of time provided above shall be the Licensee’s sole and exclusive remedy for any failure of Yokogawa to 
comply with its obligations and shall constitute fulfillment of all liabilities of Yokogawa and any third party licensing the Third Party Software to Yokogawa (including any 
liability for direct, indirect, special, incidental or consequential damages) whether in warranty, contract, tort (including negligence but excluding willful conduct or gross 
negligence by Yokogawa) or otherwise with respect to or arising out of the use of the Licensed Software.

4.6	 THE FOREGOING WARRANTIES ARE EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES OF QUALITY AND PERFORMANCE, WRITTEN, ORAL, OR 
IMPLIED, AND ALL OTHER WARRANTIES INCLUDING ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE ARE 
HEREBY DISCLAIMED BY YOKOGAWA AND ALL THIRD PARTIES LICENSING THIRD PARTY SOFTWARE TO YOKOGAWA.

Article 5 (Infringement)
5.1	 If and when any third party should demand injunction, initiate a law suit, or demand compensation for damages against the Licensee under patent right (including utility 

model right, design patent, and trade mark), copyright, and any other rights relating to any of the Licensed Software, the Licensee shall promptly notify Yokogawa in 
writing to that effect.

5.2	 In the case of the preceding Paragraph 5.1, the Licensee shall assign to Yokogawa all of the rights to defend the Licensee and to negotiate with the claiming party. 
Furthermore, the Licensee shall provide Yokogawa with necessary information or any other assistance for Yokogawa’s defense and negotiation. If and when such a 
claim should be attributable to Yokogawa, subject to the written notice to Yokogawa stated in the preceding Paragraph 5.1, Yokogawa shall defend the Licensee and 
negotiate with the claiming party at Yokogawa’s cost and expense and be responsible for the final settlement or judgment granted to the claiming party in the preceding 
Paragraph 5.1.

5.3	 When any assertion or allegation of the infringement of the third party’s rights defined in Paragraph 5.1 is made, or when at Yokogawa’s judgment there is possibility of 
such assertion or allegation, Yokogawa will, at its own discretion, take any of the following countermeasures at Yokogawa’s cost and expense.
a)	 To acquire the necessary right from a third party which has lawful ownership of the right so that the Licensee will be able to continue to use the Licensed 

Software;
b)	 To replace the Licensed Software with an alternative one which avoids the infringement; or
c)	 To remodel the Licensed Software so that the Licensed Software can avoid the infringement of such third party’s right.

5.4	 If and when Yokogawa fails to take either of the countermeasures as set forth in the preceding subparagraphs of Paragraph 5.3, Yokogawa shall indemnify the Licensee 
only by paying back the price amount of the Licensed Software which Yokogawa has received from the Licensee. 

	 THE FOREGOING PARAGRAPHS STATE THE ENTIRE LIABILITY OF YOKOGAWA AND ANY THIRD PARTY LICENSING THIRD PARTY SOFTWARE TO YOKOGAWA 
WITH RESPECT TO INFRINGEMENT OF THE INTELLECTUAL PROPERTY RIGHTS INCLUDING BUT NOT LIMITED TO, PATENT AND COPYRIGHT.

Article 6 (Liabilities)
6.1	 If and when the Licensee should incur any damage relating to or arising out of the Licensed Software or service that Yokogawa has provided to the Licensee under 

the conditions herein due to a reason attributable to Yokogawa, Yokogawa shall take actions in accordance with this Agreement. However, in no event shall Yokogawa 
be liable or responsible for any special, incidental, consequential and/or indirect damage, whether in contract, warranty, tort, negligence, strict liability, or otherwise, 
including, without limitation, loss of operational profit or revenue, loss of use of the Licensed Software, or any associated products or equipment, cost of capital, loss 
or cost of interruption of the Licensee’s business, substitute equipment, facilities or services, downtime costs, delays, and loss of business information, or claims of 
customers of Licensee or other third parties for such or other damages. Even if Yokogawa is liable or responsible for the damages attributable to Yokogawa and to the 
extent of this Article 6, Yokogawa’s liability for the Licensee’s damage shall not exceed the price amount of the Licensed Software or service fee which Yokogawa has 
received. The Licensee agrees that Yokogawa shall be released or discharged from part or all of the liability under this Agreement if the Licensee modifies, remodels, 
combines with other software or products, or causes any deviation from the basic specifications or functional specifications, without Yokogawa’s prior written consent.

6.2	 All causes of action against Yokogawa arising out of or relating to this Agreement or the performance or breach hereof shall expire unless Yokogawa is notified of the 
claim within one (1) year of its occurrence.

6.3	 In no event, regardless of cause, shall Yokogawa assume responsibility for or be liable for penalties or penalty clauses in any contracts between the Licensee and its 
customers.

Article 7 (Limit of Export)
Unless otherwise agreed by Yokogawa, the Licensee shall not directly or indirectly export or transfer the Licensed Software to any countries other than those where Yokogawa 
permits export in advance.

Article 8 (Term)
This Agreement shall become effective on the date when the Licensee receives the Licensed Software and continues in effect unless or until terminated as provided herein, 
or the Licensee ceases using the Licensed Software by itself or with Yokogawa’s thirty (30) days prior written notice to the Licensee. When aforesaid termination or cease is 
occurred, the Licensee shall immediately destroy and/or eliminate the Licensed Software and related documents without retaining any copies or extracts thereof. However, 
upon specifically instructed by Yokogawa, they shall be returned to Yokogawa or its designated third party.

Article 9 (Injunction for Use)
During the term of this Agreement, Yokogawa may, at its own discretion, demand injunction against the Licensee in case that Yokogawa deems that the Licensed Software is 
used improperly or under severer environments other than those where Yokogawa has first approved, or any other condition which Yokogawa may not permit.

Article 10 (Termination)
Yokogawa, at its sole discretion, may terminate this Agreement without any notice or reminder to the Licensee if the Licensee violates or fails to perform this Agreement. 
However, Articles 5, 6, and 11 shall survive even after the termination.

Article 11 (Jurisdiction)
Any dispute, controversies, or differences between the parties hereto as to interpretation or execution of this Agreement shall be resolved amicably through negotiation 
between the parties upon the basis of mutual trust. Should the parties fail to agree within ninety (90) days after notice from one of the parties to the other, both parties hereby 
irrevocably submit to the exclusive jurisdiction of the Tokyo District Court (main office) in Japan for settlement of the dispute to the fullest extent allowed by applicable law.

Article 12 (Governing Law)
This Agreement shall be governed by and construed in accordance with the laws of Japan. The Licensee expressly agrees to waive absolutely and irrevocably and to the 
fullest extent permissible under applicable law any rights against the laws of Japan which may have pursuant to the Licensee’s local law.

Article 13 (Severability)
In the event that any provision hereof is declared or found to be illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void with respect to 
the jurisdiction of that court or tribunal and all the remaining provisions hereof shall remain in full force and effect.
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Overview of This Manual

Structure of This Manual
This manual consists of four chapters and an index as shown below.

Chapter Title Description
1 Before Using the DataBrowser An overview of DataBrowser. Provides 

DataBrowser’s PC system requirements and 
configuration, flow of operations, and other 
information.

2 Operation of the Data Serarch 
Window

Describes methods to search for data files. 
Explains how to search by folder name, file 
date, extension, data tywi, characters, serial 
number, and other criteria; how to display 
search results; how to add channels to data; 
and other operations.

3 Operation of the Trend Display 
Window

Describes how to display data found during a 
search. Explains how to display waveforms, 
cursor values, and computed results; how to 
save settings and change data formats; and 
other operations.

4 Responding to Error Messages Lists error messages, their causes, and their 
corrective actions.

Index An alphabetical index of the manual’s contents.

Scope of This Manual
This manual explains the basic operations of the software when operated on Windows 
2000, Windows XP, and Windows Vista.  For specific information on your operating 
system please refer to the user’s guide that came with it.

Conventions Used in This Manual
•	 Unit
	 K:	 Denotes 1024.  Example: 100 KB
	 M: 	 Denotes 1024 K.  Example: 10 MB
	 G:	 Denotes 1024 M.  Example: 2 GB

•	 Bolded Items
	 Hardware and software controls that the user manipulates such as dialog boxes, 

buttons, and menu commands are often set in boldface type.

•	 Subheadings
	 On pages in chapters 1 through 3 that describe operating procedures, the following 

subheadings are used to distinguish the procedure from their explanations.

			 

Procedure

Explanation

Carry out the procedure according to the step numbers.
All procedures are written with inexperienced users in mind;
depending on the operation, not all steps need to be taken.
Explanation gives information such as limitations related the
procedure.

			   Note Calls attention to information that is important for proper operation 
of the instrument.
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Chapter 1	 Before Using the DataBrowser

1.1	 Overview of DataBrowser

Functional Overview
DataBrowser is a software application providing data file searching and display functions.  
It allows you to search for and display data files saved by Yokogawa recorders and data 
acquisition software programs from a local or network host.

Note
Hosts on the network must be running DataBrowser.

Data Search Function (Search Window)
Five categories of search conditions are available, making entry of criteria simple. Also, 
you can select multiple search conditions to refine your searches.
(1) Time
	 You can search for files of a specific year, month, date, and time (Time Range), or for 

those of a specific time range regardless of the day (Time Range each day).
(2) File Name
	 Search for data files of a specified file name or extension.
(3) Data Type
	 Search for data files from a specific instrument (DX100/200, CX1000/2000, MX100,  

MV100/200, or FX100) or data acquisition software application (DAQLOGGER, 
AddTrigger, or AddMulti).

(4) Keywords
	 Search for data files containing a specified keyword(s).
(5) Serial Number
	 Search for data files of the specified instrument serial number.

Data Display Function (Trend Display Window)
•	 You can display waveforms of data having different times and acquisition intervals, 

and obtained by different instruments and applications, all on the same screen.
•	 You can read values using cursors, and compute statistics over an area.
•	 Data can be converted to Excel, text, or Lotus format.
•	 All data, or a range of data specified by the cursor can be printed.

Diagram of Data Saving and Loading

		

Trend settings
files

Seach settings
files

Search results files

Trend settings
files

Seach settings
files

Search results files
Load

Load

Save
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Diagram of Data Searching and Display
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Each host must be running 
DataBrowser.

Communication with Network Hosts
DataBrowser can communicate with hosts on the network (other PCs running 
DataBrowsers) and execute searches, obtain data, download specified files, and acquire 
search results.  The following is an description of the communication that occurs when 
executing functions on a DataBrowser network host from another DataBrowser.  
For each request, (1) a connection with the host is made, (2) the request is sent and the 
response is received, (3) then the connection is closed.  The connection with the host is 
not always open.  Rather, it only opens when the request is issued.  

		

Requesting PC
Requests conection

Closes connection

Allows connectiion

Sends request

Sends results of request

PC processing request

1.1  Overview of DataBrowser
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1.2	 System Requirements

Operating System (OS)
	 Run DAQWORX under any of the following operating systems.

•	 Windows 2000 Professional SP4
•	 Windows XP Home Edition SP2, SP3
•	 Windows XP Professional SP2, SP3 (excluding Windows XP Professional x64 

Edition)
•	 Windows Vista Home Premium, SP1 (excluding the 64-bit edition)
•	 Windows Vista Business, SP1 (excluding the 64-bit edition)

	 The language displayed by the software under different language versions of the OS 
are as follows.
OS Language Software Language
Japanese Japanese
Other English

Note
This manual uses screens displayed on Windows 2000 to describe the procedures.

PC
A PC that runs one of the OS above, and that meets the following CPU and memory 
requirements.
	 When Using Windows 2000 or Windows XP

Pentium 4, 1.6 GHz or faster
512 MB or more of memory

	 When Using Windows Vista
Pentium 4, 3 GHz or faster
2 GB or more of memory 

Note
The specifications above are for a desktop PC, not a notebook PC.

Hard Disk
Free disk space: 200 MB or more

CD-ROM Drive (for Use during Installation)

Monitor
	 When Using Windows 2000 or Windows XP
	 A monitor supported by the OS of 1024 × 768 dot or higher and 65,536 colors or more. 
	 When Using Windows Vista
	 A video card recommended for use with Vista and a monitor supported by the OS of 

1024 × 768 dot or higher and 65,536 colors or more.

Printer and Mouse
A printer and mouse supported by the OS.

Ethernet Port
An Ethernet compatible  port (10BASE-T or 100BASE-TX).
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1.3	 Starting and Exiting the Software

Starting the Software
Procedure

1.	 From the Windows Start menu, choose Programs > YOKOGAWA DAQWORX > 
DataBrowser > DataBrowser.

	 DataBrowser starts.

Note
When you start DataBrowser, it is restored to the same configuration that was active during the 
previous session. However, the search results in memory when exiting the software cannot be 
recovered in subsequent sessions.

Exiting the Software
Procedure

1.	 Choose File > Exit  from the menu bar, or click the  button at the right end of 
the title bar.

	 DataBrowser closes.
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1.4	 Flow of Operations

The figure below shows the general flow of operation when using DataBrowser.

Display cursor
values

Save and load
trend setting

Convert data
formats Print the dataDisplay computed

results

Start DataBrowser.

Register and specify search 
folders

Save and load search 
conditions and result

Dopy data files

Searches within search results

Specify search conditions Specify search conditions

Execute searchs Narrow the search results

Display search results

Add channels from search 
results to the trend display

Select group for adding 
channels

Channel display configure
screen settings

Trend display screen

See section 1.3

See section 2.2 See section 2.7

See section 2.3 See section 2.3

See section 2.5See section 2.4

See section 2.5

See section 2.6 See section 2.8

See section 3.2

See section 3.3

See section 3.4

See section 3.5 See section 3.6 See section 3.7 See section 3.8 See section 3.9
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Chapter 2	 Operation of the Data Search Window

2.1	 Names of Parts in the Data Search Window

“Show the file information display” button

Resize button

Toolbar

Menu bar Toolbar

Menu bar

Search paths area Search conditions area

Search results area File details area

(1)

(1)

(2)

(2)

(3)

(3)

(4)

(4)

(5)
(6)

(7)

(7) (8) (9)

(8)

(5) (6)

(10)
(9)

(10)

(1) Loads search settings from local or network 
hosts and displays them.

(2) Opens a new Search window.
(3) Opens a new Trend display window.
(4) Saves search folder and search condition 

settings to the local host.
(5) Loads search results from local or network 

hosts and displays them.

(6) Saves search results to the local host.
(7) Copies data files from a specified folder to 

another folder.
(8) Displays the Search window.
(9) Displays the Trend Display window.
(10) Displays version information.
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2.2	 Registering and Specifying Search Folders

You can register source folders for data file searches.  Up to two hundred folders can be 
registered, and up to eight of those can be specified at a time for a search.

Registering New Search Folders
The following is the procedure for registering new source folders for searches on local or 
network hosts.

Procedure
1.	 Open the Search window, then click the Add button in the Search paths area.  

The Search Path Configuration dialog box is displayed.

					   

Folder ID box

Update button

2.	 Select a folder to register, then enter a folder ID.

3.	 Click the Add button. The host name and ID of the registered folder appears in 
the Search paths area (the folder’s check box is selected, indicating that it will be 
included in any searches performed).

					   

Drag to change 
the column width

Select to assign folders
to be searched

Explanation
Search Paths Area

Host Name
	 The name of the host of the registered folder.
Folder ID
	 The name specified for the folder when it was registered.
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Add button
	 The Search Path Configuration dialog box is displayed when this button is clicked.
Remove button
	 Deletes the selected folder registration from the Search paths area.
Search source check boxes
	 Select or clear the check boxes to include or exclude folders from searches.

Search Path Configuration Dialog Box
Update button
	 Updates the directory tree for the local host.
Folder ID Box
	 You can enter an identifying string for the folder using up to sixteen alphanumeric 

characters.  The folder ID is registered along with the folder.
Add button
	 Registers the selected folder using the specified folder ID.
Close button
	 Closes the Search Path Configuration dialog box.

Note
•	 Two or more folders cannot be registered under the same folder ID.
•	 Registered folders are shown under Folder List in the Registration from list tab of the Search 

Path Configuration dialog box.  Up to two hundred folders can be registered.  If you need 
to register a new folder when two hundred have already been registered, first delete one or 
more of the registered folders from the folder list.

Specifying a Folder from the List
The following is the procedure for selecting a search folder from the list of registered 
folders from local or network hosts.

Procedure
1.	 Open the Search window, then click the Add button in the Search paths area.  

The Search Path Configuration dialog box is displayed.

2.	 Click the Registration from list tab. The Registration from list tab is displayed.

					   

Update button

Delete button

Acquire button

Drag to select range of folders

Double-click number to specify individual folders

Click to select all folders

3.	 Select a host from the Host List.   The folders registered under the selected host 
appear in the Folder List.

2.2 Registering and Specifying Search Folders
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4.	 Select a folder and click Add, or double-click the folder number.  The host name 
and ID of the specified folder appear in the Search paths area (with check box 
selected).

					     Drag to change 
the column width

Select to assign folders
to be searched

Explanation
Host List
	 The Host List displays any hosts on the network that are running DataBrowser.  Up to 

two hundred hosts can be displayed.
Folder List
	 The Folder List displays the folder ID and paths registered to the host selected in the 

host list.  Up to two hundred folders can be displayed.
Update button (red circular icon)
	 Updates the host list and folder list.
Update button (green arrow icon)
	 Updates the folder list for individual hosts.
Remove button 
	 Deletes folders from the folder list.  (You can only delete folders registered to the local 

host.)
Add button
	 Adds the folder specified in the folder list to the Search paths list in the Search 

window.

Registering a Folder from the Explorer
Procedure

1.	 Open the Search window. Drag a folder you wish to register from the Windows 
explorer (from a folder) onto the Search window.  The Reg. of search paths dialog 
box is displayed.

					   

Search window

Drag folder to the search window.

2.2 Registering and Specifying Search Folders
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Enter folder ID

2.	 Enter a folder ID and click the Add button. The host name and ID of the registered 
folder appears in the Search paths area  (the folder’s check box is selected, 
indicating that it will be included in any searches performed).

Explanation
Path
	 The Path column shows the absolute path to the folder that was dragged.

Note
•	 Two or more folders cannot be registered under the same folder ID.
•	 Registered folders are shown under Folder List in the Registration from list tab of the Search 

Path Configuration dialog box.  Up to two hundred folders can be registered.  If you need 
to register a new folder when two hundred have already been registered, first delete one or 
more of the registered folders from the folder list.

Notes When Registering Search Folders
Note

•	 Even if you delete a folder from the Search paths area, the folder is not removed from the 
Folder List.  Likewise, even if you delete a folder from the Folder List, it is not removed from 
the Search paths area.

•	 A new folder cannot be registered under the same folder ID as one that is currently 
registered in the Search paths area.

•	 Likewise, a new folder cannot be registered under the same folder ID as one that is currently 
registered in the Folder List area.   However, the same folder can be registered twice under 
a different folder ID.

2.2 Registering and Specifying Search Folders
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2.3	 Specifying Search Conditions

The following five categories of search criteria can be used. Multiple search conditions 
can be specified.
•	 Date and/or time range
•	 File name or extension
•	 Data type
•	 Keywords
• 	 Serial numbers

Specifying a Date and/or Time Range
Procedure

1.	 Specify a search folder.   (See section 2.2)

2.	 Select the Time check box in the Search conditions area.

3.	 Click the Time tab or click the word “Time” to the right of the check box.  The Time 
tab is displayed.

					   

Click to the right of each item to change the tabs on the right.

Check box

4.	 Select Time Range (for a specific day) or Time Range each day (for any day).

5.	 Enter a range of dates and time (by year, month, date, and time), or a daily time 
range.

Explanation
Date and time specification allows you to search for files containing data acquired on 
certain dates and times.
•	 Milliseconds cannot be specified here, and any milliseconds in files are read as “0” by 

the program.
•	 The files included by the date and time specification range are shown in the figure 

below.
	 Given date/times A and B, the search finds any files containing data between A and B.  

As long as the file contains data between A and B, it is found even if it also contains 
data prior to A.  Likewise, it is found if the start date/time is between A and B.  Files (1), 
(2), and (3) are found, but not file (4).

				  

A
13:00:00

9:00:00 to 13:00:50

B
15:00:00

9:00:00 to 17:00:00

13:10:00 to 14:45:00

9:00:00 to 12:45:00 15:00:30

14:30:00 to 17:00:00(1)

(3)

(4)

(2)
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Specifying a File Name or Extension
Procedure

1.	 Specify a search folder.   (See section 2.2)

2.	 Select the File Name check box in the Search conditions area.

3.	 Click the File Name tab or click the words “File Name” to the right of the check 
box. The File Name tab is displayed.

					   

Click to the right of each item to change the tabs on the right.

Check box

4.	 Select the File Name or Extension option.

5.	 Enter the file name or extension to use as a search criterion.

Explanation
File name specification allows you to search for files whose names contain the specified 
keyword or extension.
File Name
	 You can enter an entire file name or portion thereof.
Extension
	 You can enter an entire file name extension or portion thereof.

Note
To specify multiple files names or extensions, use a space as a delimiter. Note that wildcards (*, 
?, etc.) are not allowed.

2.3 Specifying Search Conditions
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Specifying Data Types
Procedure

1.	 Specify a search folder.   (See section 2.2)

2.	 Select the Data Type check box in the Search conditions area.

3.	 Click the Data Type tab or click the word “Data Type” to the right of the check box.  
The Data Type tab is displayed.

					   

Click to the right of each item to change the tabs on the right.

Check box

4.	 Select the types of data to search for.

Explanation
Data type specification allows you to search for files of the specified instrument or PC 
software.
Data Types
	 DAQLOGGER, AddMulti, AddTrigger, MX100, DX100/DX200, MV100/MV200, and 

CX1000/CX2000, FX100

Specifying Keywords
Procedure

1.	 Specify a search folder.   (See section 2.2)

2.	 Select the Keyword check box in the Search conditions area.

3.	 Click the Keywords tab or click the word “Keywords” to the right of the check box.  
The Keywords tab is displayed.

					   

Click to the right of each item to change the tabs on the right.

Check box

4.	 Select a search key, then enter a keyword or keywords to search for.

2.3 Specifying Search Conditions
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Explanation
Keyword specification allows you to search for files that contain the keywords in their text 
or data.  Files that do not contain any data of the specified search key are not included in 
the search. The table below shows the types of data available by product.

DAQLOGGER AddMulti AddTrigger MX100 DX100/200 MV100/200 CX1000/2000 FX100
File comments      
Batch information   
Tag comments        
Tag numbers    
Channels        
Group names        
Marks/Messages        

 : data type exists in data file, Blank: data type not included

Note
•	 You can specify multiple keywords by separating them with a space.
•	 If multiple search keys are selected, the software searches for files whose keywords are 

found in data corresponding to all of the keys.
•	 Up to one thousand marks/messages can be found per file.  All other marks or messages 

thereafter are not found.

Specifying a Serial Number
Procedure

1.	 Specify a search folder.   (See section 2.2)

2.	 Select the Serial No. check box in the Search conditions area.

3.	 Click the Serial No. tab or click the words “Serial No.” to the right of the check 
box.  The Serial No. tab is displayed.

					   

Click to the right of each item to change the tabs on the right.

Check box

4.	 Enter a serial number.

Explanation
Serial number specification allows you to search for data files of the specified instrument 
serial number.

Note
•	 DAQLOGGER, AddMulti, and AddTrigger do not have serial numbers, and therefore data 

acquired by those programs cannot be searched for using this criterion.
•	 Enter the serial number carefully as only exact matches will be found.

2.3 Specifying Search Conditions
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Specifying Search Conditions
Explanation

Specifying Multiple Search Conditions
	 You can apply multiple or even all entered search conditions to the same search, 

including date and/or time, file name, data type, keyword, and serial number.  
	 As in the figure below, the major search categories are combined in an AND 

relationship, and the conditions within each category are applied in an OR relationship.  
	 When specifying search items, for example date/time and data type, files with data 

from the specified date/time and of the specified data type are found.
	 When specifying search conditions within a tab, for example two or more data types, 

files of any of the specified type are found.

			 

AND relationship OR relationship

Searching Subfolders
	 If you select Search subfolders, any subfolders existing in the registered search paths 

are included in the search.  If Search subfolders is not selected, any subfolders within 
the primary search folders are not included.

			 

DataFolder
Folder1

AddMulti
AddTrigger
DAQLOGGER

CX
DX
MV
MX

Folder2
(4)
(5)
(6)
(7)
(8)
(9)

(1)
(2)
(3)

If Search Subfolders is Cleared If Search Subfolders is Selected

Specified search folder

• Searches only the files within the specified 
folder

• Data files (1) to (9) are not searched

• Searches the subfiles within the specified 
folder

• All data files (1) to (9) are searched

Note
The maximum allowable length for a path is 255 characters including the file name.

2.3 Specifying Search Conditions
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2.4	 Executing the Search

Procedure
1.	 Specify search folders and search conditions.    (See sections 2.2 and 2.3)

2.	 Click the Search button in the Search conditions area. (Select the Search 
subfolders check box if necessary.

					   

	 The Search status dialog box appears.

					   

When searching

Changes to the Close button when the serach stop.

Click to view contents of the error

Explanation
Host Name
	 Displays the name of the host containing the specified search folder.
Folder ID
	 Displays the folder ID of the specified search folder.
Status (left)
	 Displays the search status.

	 Starting → Searching → Receiving data in progress ...% → Finished
	 Error: An error occured during the search.
	 Stop: Press to stop the search.

Status (right)
	 Displays the results of the search.  The number to the left of the slash indicates the 

number of files that matched the criteria, and the number to the right represents the 
total number of files searched. The number of files that can be searched from a single 
registered folder ID is sixty thousand.  Once that limit is reached, the search stops.

Error button
	 If an error occurs, the button becomes “  ” You can click the Error button to display 

the contents of the error message.
Error
	 Displays the error number and message.
Total 
	 Displays the total number of files found and searched.
Stop button
	 Stops the search. Once a search is stopped, the results obtained in progress are 

displayed.
Close button
	 Closes the Search status dialog box. When the search stops, the Stop button changes 

to the Close button.
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2.5	 Displaying Search Results

Displaying the Search Status
Procedure

1.	 When a registered folder is searched with specified conditions, the search results 
are displayed in the Search results area.

	 Registering Search Folders (section 2.2), Specifying Search Conditions (section 
2.3), Executing the Search (section 2.4)

Click a file in the search results area 
to display its details

Display last page

Resize button

Display next pageDisplay previous page
Display first page

Explanation
Search Results Area
	 Displays any found files in a list.  The list is located in the lower left part of the screen.  

	 File Name:	 The names of the found files.
	 Data Type:	 The data type of the found files.
	 Start Time:	 The time of the first data in the found files.
	 End Time: 	 The time of the last data in the found files.
	 Title:	 Any titles given to the found files.
	 Comment: 	 Any comments included with the files.
	 Host Name[Folder ID]: The host name and folder ID of the found files.

Note
•	 Data files are listed in the order in which their hosts were registered.
•	 If multiple titles and comments exist, only the first title or comment is displayed.
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Specifying Pages
	 One hundred search results are displayed on a single page. If several pages are 

generated, you can access other pages by clicking the arrow buttons in the upper right 
of the Search results area.

Open button
	 Opens previously saved search results files.  (See section 2.6)
Save button
	 Saves the currently displayed search results.   (See section 2.6)
Sort Function
	 You can sort the search results by various items.  When you click a column title in the 

search results display, the Sort Status dialog box appears, and the results are sorted 
according to the information in that column.

					   

	 If you click the Stop button during the sort, the items are restored to their original 
order.

Resize button
•	 Clicking this button widens the search results area to its maximum width. Click the 

Resize button again to restore the window to its original size.
•	 You can also drag the button to the right to size the window manually.  (Unless the 

area is already at its maximum width)

Narrowing the Search Results
Procedure

1.	 Specify search conditions.

2.	 Click the Search within results button in the Search conditions area. 

					   

Explanation
The Search within results button allows you perform a search of the files found during the 
previous search.  This function allows you to do the following.

•	 When a large number of search results are obtained, you can find desired files by 
applying new conditions and searching through those results.

•	 If you save the search results (see section 2.6), you can perform multiple, different 
searches on those results. By combining the Save/Open functions with the Search 
within results function, you can create a search results file that fits your particular 
task.

Note
The Search within results function searches on-screen files, and does not perform 
communication.  Searching within results can be performed on the local data, but data from 
files found on a network host cannot be displayed (see chapter 3).  To display data, the network 
hosts must be running DataBrowser.

2.5 Displaying Search Results
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Displaying File Details
Procedure

1.	 Click a file in the search results area to display its details in the File Details area. 

Click the tag display switching buttons to display
the channel, Tag No., or Tag comment.

Show the file information display
button

Tag display 
switching
buttons

Explanation
Host Name [Folder ID]
	 Displays the host name and folder ID.
Channels
	 Displays the number of channels in the current file.
File Name
	 Displays the path and file name of the current file.
No.
	 A number for the files in the list.
Add
	 A button for adding the item to the trend display.  (See section 2.7)
Tag display switching buttons
	 Channel: Displays the channel numbers.
	 Tag No.: Displays the tag numbers.
	 Tag Comment: Displays the tag comments.
Interval [sec]
	 Displays the save interval for each channel.
Size [samples]
	 Displays the number of data for each channel.
Serial No.
	 Displays the serial number for each channel.
Start Time
	 Displays the time of the first data for each channel.
End Time
	 Displays the time of the last data for each channel.
Trigger Time
	 Displays the trigger time for each channel.

2.5 Displaying Search Results
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Note
Tag numbers and serial numbers are not displayed for the following data types.
Tag numbers	 CX1000/2000, DX100/200, MV100/200, FX100
Serial numbers	 DAQLOGGER, AddMulti, AddTrigger, MX100
Serial numbers are also not displayed for computation-only data from the MX100, and for data 
saved by Viewer.

“Show the file information display” button
	 Click this button to display the Datafile Information dialog box for the found file.

				  

Click to select a tab

	 Comment
	 Displays the comments (title and comment) for the selected data file.  If no data 

exists, nothing is displayed.
	 Mark/Message

	 Displays the number and text of marks for the selected data file. If no data exists, 
nothing is displayed.

	 Batch Information
	 Displays the batch information (Application, Supervisor, Manager, Batch Name, 

Comment User, Comment) for the selected data file. If no data exists, nothing is 
displayed.

	 Group Name
	 Displays the number and names of groups for the selected data file. If no data 

exists, nothing is displayed.

2.5 Displaying Search Results
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2.6	 Adding Channels from Search Results to the 
Trend Display Window

The following describes the procedure for adding channels from the search results to the 
Trend display window.

Collectively Adding a Selected Range of Channels
Procedure

1.	 Select a file from the search results area to display its details. (See section 2.5)

2.	 Select a range of channels to add and click the  Add channels to this trend 
configuration button.

					   
Drag to 
select range

Add channels to this trend configuration
button

Click to select/clear 
all channels

Adding Individual Channels
Procedure

1.	 Select a file from the search results area to display its details. (See section 2.5)

2.	 Click the Add button next to the channel to add, or double-click its number.

					   

Click the Add 
buttons

Add button Double-click

Note
The Add buttons are hidden if the File Details area is scrolled to the right.  In this case, you can 
double-click the item or click the Add channels to this trend configuration button.
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2.7	 Saving and Loading Search Settings and 
Results

Saving Search Settings
Procedure

1.	 Click  on the toolbar or choose File> Save search settings as from the menu 
bar. The Save search settings dialog box appears.

					   

Search settings file icon

Drag to change the column width

Update button

Delete button

2.	 Enter a file name and comment and click the Save button.

	 The currently specified search folder and search conditions are saved.

Explanation
File List
	 Displays the search settings file name and comments of the search settings saved on 

the local host.
Delete button
	 Deletes the selected search settings file.
Update button
	 Updates the displayed search results file list.
File Name
	 Enter the name of the file you wish to save. (An extension is automatically added.)
Comment
	 Enter comments to be saved with the file.  Up to 255 alphanumeric characters can be 

entered.
Save button
	 Saves the settings file under the specified file name on the local host.

Note
After saving a search settings file, the saved file name and comment appears in the text box 
the next time you open the Save search settings dialog box (these items are blank if no settings 
have been saved previously, or when starting up the software).  Also, when you select a file in 
the Save search settings dialog box, the file and comment are displayed in the input boxes at 
the bottom of the window.  This allows you to conveniently overwrite settings.
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Opening Search Settings from a Local Host
Procedure

1.	 Click  on the toolbar or choose File> Open  from the menu bar. The Open 
dialog box is displayed.

					   
Drag to change the column width

Update button

Delete button

Double-click a number to open the file

2.	 Select a file and click Open, or double-click the file number. The Information 
dialog box opens.

					   

3.	 Click the Yes button. The search paths and search conditions loaded from the 
search settings file are displayed.  Click No to close the Information dialog box.

Explanation
File List
	 Displays the name of the settings file and comments saved on the local host.
Delete button 
	 Deletes the selected file.
Update button 
	 Updates the displayed file list.
File Type
	 If you select all files (.dbc; .dbv), the saved search settings files and display settings 

files are displayed.
	 If you select Search settings file (.dbc), only the search settings files are displayed.
	 If you select Trend settings file (.dbv), only the display settings files are displayed.
Open button
	 Opens the settings file selected in the File List.  When a search settings file is opened, 

the Search window becomes active.  (When a trend settings file is opened, the Trend 
display window becomes active.)

Cancel button
	 Closes the Open dialog box.

2.7 Saving and Loading Search Settings and Results
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Opening Search Settings from a Network Host
Procedure

1.	 Click  on the toolbar or choose File> Open  from the menu bar. The Open 
dialog box is displayed. 

2.	 Click the Hosts on network tab. The Hosts on network tab is displayed. 

3.	 Click the Update button. The names of hosts running DataBrowser, and their 
corresponding files names and comments are displayed.

					   

Update button

Drag to change the column width

Double-click a number to open the file

4.	 Select a host from the Host List.   The a list of files saved on the selected host is 
displayed.

5.	 Select a file from the list that you wish to load and click Open, or double-click the 
file number. The Information dialog box opens.

					   

6.	 Click the Yes button. The search paths and search conditions loaded from the 
search settings file are displayed.  Click No to close the Information dialog box.

Explanation
Host List
	 The Host List displays the names of any hosts on the network that are running 

DataBrowser.  Up to two hundred hosts can be displayed.
File List
	 Displays the settings files and comments saved on the host selected in the host list.
Host Name
	 Displays the name of the host selected in the host list.
Update button 
	 Updates the host list and file list.
File Type, Open Button, and Cancel Button
	 See Opening Search Settings from a Local Host.

2.7 Saving and Loading Search Settings and Results
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Saving Search Results
Procedure

1.	 Click the Save button in Search results area or choose File> Save the search 
results as from the menu bar. The Save dialog box appears.

					   

Drag to change the column width

Update button

Delete button

2.	 Enter a file name and comment and click the Save button.

	 The displayed search results are saved.

Explanation
File List
	 Displays the name of the search results file and comments saved on the local host.
Delete button
	 Deletes the selected search results file.
Update button
	 Updates the displayed search results file.
File Name
	 Enter the name of the file you wish to save. (An extension is automatically added.)
Comment
	 Enter comments to be saved with the file.  Up to 255 alphanumeric characters can be 

entered.
Save button
	 Saves the search results file under the specified file name on the local host.

2.7 Saving and Loading Search Settings and Results
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Opening Search Results from a Local Host
Procedure

1.	 Click the Open button in Search results area or choose File> Open the search 
results from the menu bar. The Open dialog box is displayed.

					   

Drag to change the column width

Update button

Delete button

Double-click a number to open the file

2.	 Select a file and click Open, or double-click the file number. The Information 
dialog box opens.

					   

3.	 Click the Yes button. The search results loaded from the search results file are 
displayed.  Click No to close the Information dialog box.

Explanation
File List
	 Displays the name of the search results file and comments saved on the local host.
Delete button
	 Deletes the selected file.
Update button
	 Updates the displayed file list.
Open button
	 Opens the search results file selected in the File List.
Cancel button
	 Closes the Open dialog box.

2.7 Saving and Loading Search Settings and Results
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Opening Search Results from a Network Host
Procedure

1.	 Click the Open button in Search results area or choose File> Open the search 
results from the menu bar. The Open dialog box is displayed.

2.	 Click the Hosts on network tab. The Hosts on network tab is displayed.

3.	 Click the Update button. The names of hosts running DataBrowser, and their 
corresponding files names and comments are displayed.

					     Drag to change the column width

Update button

Double-click a number to open the file

4.	 Select a host from the Host List.   The a list of files saved on the selected host is 
displayed.

5.	 Select a file from the list that you wish to load and click Open, or double-click the 
file number. The Information dialog box opens.

					   

6.	 Click the Yes button. The search results loaded from the search results file are 
displayed.  Click No to close the Information dialog box.

Explanation
Host List
	 The Host List displays the names of any hosts on the network that are running 

DataBrowser.  Up to two hundred hosts can be displayed.
File List
	 Displays the settings files and comments saved on the host selected in the host list.
Host Name
	 Displays the name of the host selected in the host list.
Update button
	 Updates the host list and file list.
Open Button and Cancel Button
	 See Opening Search Results Files from a Local Host.

2.7 Saving and Loading Search Settings and Results
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2.8	 Copying Data Files

This section describes the procedure for copying a data file from a specified folder to 
another folder.

Procedure

1.	 Click  on the toolbar or choose File > Import Data Files from the menu bar. 
The Import Data files dialog box opens.

					   

2.	 Click the Select button for the Source. The Browse for Folders dialog box is 
displayed.

					   

3.	 Select a source folder and click the OK button. The Import Data files dialog box 
reappears.

4.	 As in step 2, click the Select button for the Destination. The Browse for Folders 
dialog box is displayed.

					   

	 If you do not want to create a new folder, skip to step 7. 
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5.	 Select a location in which to create a new folder, and click the New Folder button. 
The Create New Folder dialog box is displayed.

					   

6.	 Enter the name of the folder to be created, and click the OK button.  The Browse 
Folders dialog box is displayed (the screen in step 4).

7.	 Select the destination folder and click the OK button. The Import Data files dialog 
box reappears.

					     	

8.	 Click the Start button. When copying is complete, “Completed”is displayed in the 
bottom of the Import Data files dialog box along with the number of copied files.

					   

Explanation
The Import Data files function allows you to copy data files saved on the floppy disk or 
CF card of a recorder to a specified folder.  By specifying a copy source and destination 
the first time you import files, subsequent imports can be done quickly and easily.

Note
Only folders on the local host can be specified as the source and destination folders.

Select Buttons (Import Data files Dialog Box)
	 A folder for specifying folders is displayed.
New Folder (Browse Folders Dialog Box)
	 Lets you create a new folder in a specified location. The Create New Folder dialog box 

is displayed.
Start Button (Import Data files Dialog Box)
	 Executes the import of data files.  This button is not active unless a source and 

destination folder are selected.
Stop Button (Import Data files Dialog Box)
	 Becomes available once importing has started.  Stops the importing of data files.
Close Button (Import Data files Dialog Box)
	 Closes the Import Data files dialog box.
OK Button (Create New Folder Dialog Box)
	 Creates the new folder.
Cancel Button (Create New Folder Dialog Box)
	 Cancels creation of the new folder and closes the Browse Folders dialog box.

2.8 Copying Data Files
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Chapter 3	 Operation of the Trend Display Window

3.1	 Names of Parts in the Trend Display Window

The Trend display window consists of the display channel settings screen and the 
waveform display screen.

Opening the Trend Display Window
Procedure

1.	 Click  on the toolbar or choose View> Trend display from the menu bar. The 
Trend display window opens.

Display Channel Setting Screen
The display channel setting screen can display the channel information screen, or the 
channel display configure screen, each of which contain channels added from the search 
results.

Channel Information Screen

Menu bar Toolbar
Display Channel Setting Screen Toolbar
Display Channel Setting Screen groups toolbar

Channel Display Configure Screen
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Explanation
Group Name
	 You can specify a group name using up to thirty alphanumeric characters.
No.
	 Number assigned within groups.
Channel, Tag Number, and Tag Comment
	 Displays identifiers for the channels (display can be switched using the group tab tool 

bar).
Start Time
	 Time of the first data.
End Time
	 Time of the last data.
Trigger Time
	 Time of the trigger point (if no trigger point exists, the first data is used.)
Interval [sec]
	 The save interval for the data.
Data Size
	 The number of saved data.
Data Type
	 The instrument or software that saved the data.
File Name
	 Name of the file to which the channel belongs.
Host Name
	 Name of the host on which the channel to which the file belongs resides.
Toolbar

			 

Displays version information.
Displays the Trend display window.

Displays the Search window.
Copies data files

Saves Trend settings files
Opens Trend settings files

Opens new Trend Display window.
Opens new Search window.

Display Channel Setting Screen Toolbar (for Channel Info and Configure 
Screens)

			 

Displays channel details.
Moves groups 
(forward, backward)

Copy/Paste

Linked group setting
(OFF, 1, 2, 3, 4)

Switches between Channel,
Tag No., and Tag Comment
Opens the trend display screen.

Opens the channel setup screen.

Adds/deletes groups

Display Channel Setting Screen Group Tab Toolbar

			 
Moves channels (up and down)

Displays channel display configuration

Deletes channels

Displays channel information

3.1  Names of Parts in the Trend Display Window
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Editing Functions in the Channel Display Configure Screen

Click this button
to reset to default

Click to select for 
Copying/Pasting.
The flaf is display.

Click this button to
turn all select buttons
ON/OFF collectively

Click this button to set all
to the same as the top of 
the selection

Click to select all Paste
Copy

Drag to select a range

Copy
	 Copies the selected range to the clipboard.
Paste
	 Pastes copied contents to the displayed group.  If a range is selected, pastes the 

contents into that range.  If a range is not selected, the contents are added at the 
bottom.

3.1  Names of Parts in the Trend Display Window
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Waveform Display Screen
Displays the waveforms of the channels in the channel information screen.

			 

Menu bar Toolbar Waveform Display Screen Toolbar

Waveform Display Screen Toolbar

		

Switches the time reference mode
(Start, Trigger, End, Time)

Delete cursors
Select all

Copy

Shows channel details
Displays conversion settingsSwitches between

absolute time/Relative time

Zoom in and out, display all,
specify factor

Displays computed results 
(statistcs)

Displays the cursor values
Clip

Scale calculation
Switches the trend display
(User zone, Edit zone, Full zone, Side zone, Auto zone, Multi-zone)

Reacquires channel data

Linked group settings
(OFF, 1, 2, 3, 4)

Switches between Channel,
Tag No., and Tag Comment

Opens the trend display screens
Opens the channel setup screens

Shows/hides alarms

3.1  Names of Parts in the Trend Display Window
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3.2	 Selecting a Group for Adding Channels

Channels can be assigned to groups in the channel display configure screen.  Up to fifty 
groups can be created, each with up to thirty-two channels.  When channels are added in 
the Search window (see section 2.6) they are added to the selected groups.

Adding and Deleting Groups
Clicking the  button in either of the channel setup screens adds a new group tab on 
the end of any existing tabs.
Clicking the  button in either of the channel setup screens deletes the currently 
displayed group tab.

Linked Group Settings
This function links cursor positions and time reference modes across groups in the trend 
display screen. The available settings are Link OFF, Link 1, Link 2, 3, and 4.  You can 
select either from any group. Groups with the same link number are called linked groups, 
and up to four linked groups can be set.

			 

Select a group, then select one of the options
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3.3	 Settings in the Channel Setup Screens

Procedure
You can edit display settings by following the indications in the figure below.

Turn waveforms ON/OFF
Select channels

Select channels

Turns the Y-axis ON/OFF 
when in multi-zone display 

Select Y-axis type (linear or logarithmic)

Select a scale value display 
format (floating point or exponeial)

Specify a waveform 
display zone

Channel display
color

Turn trip point
ON/OF

Switch the displayed group
Display channel details.

Set linked groups (OFF, 1, 2, 3, 4)

Swich between the display channel settings screen 
and waveform display screen

Add/delete/move forward/backward groups

Delete channels or move them (up and down)

Switch between the channel Information and 
channel display configure screensSelect/clear all channels

Explanation
Display/Hide Channels
	 By selecting and clearing the check buttons in the No. column on the channel display 

configure screen, you can select whether to display those channels”data in the Trend 
display screen.

Channel (Tag Number and Tag Comment): Can be selected/deselected for 
display.
	 The Channel column displays the channel, tag number, and tag comment.
Display/Hide Y-Axis and Type
	 By selecting and clearing the check buttons in the Y-axis column, you can select 

whether to display the Y-axes of the corresponding channels in the Trend display 
screen.  This setting is only valid if multiple zones are specified in the Trend display 
screen.
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Minimum and Maximum Values of Scale, and the indstart Scale Value 
Display Format instop
	 You can set the maximum and minimum values of the scale when displaying waveforms. 

The value in the Scale Min column is the lower end of the Y-axis, and that of the Scale 
Max column is the upper end.

	 In the Form. column, you can specify floating point or exponential format for the scale 
values.

			 

Selects exponential display Waveform Display Screen

Setting the Waveform Display Zones
	 You can set waveform display range for displaying trends. The waveform display 

range is set as 0% at the bottom, and 100% at the top.  The values in the Zone Min 
and Max columns represent the lower (0-9%) and upper (1-100%) ends of the trend 
display range.

			 

Waveform Display Screen

Setting Trip Points
	 You can display a trip line to indicate a particular value of interest (trip point) in the 

trend display area. Two trip points (trip 1 is red, trip 2 is blue) can be set for each 
waveform. By selecting and clearing the check buttons in the Trip 1 and Trip 2 
columns, you can select whether to display the corresponding trip points in the Trend 
display screen.

			 

Trip line ON/OFF

Waveform Display Screen

Trip line

Trip 1 value Trip 2 value

3.3  Settings in the Channel Setup Screens
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Channel Display Colors
	 You can assign colors to channels displayed in the trend display screen.  Click the 

colored part to open the Color Settings dialog box.

				  

Showing Channel Details
	 You can view detailed information about a channel selected in the channel setup 

screens.
•	 Click  in the channel setup screen toolbar. The Channel Information dialog box 

opens.

				  

Name of currently displayed group

Displays the comment information page
Displays the batch informaition page

Number assigned within groups
Channel
Tag number Channel identifiers
Tag comment
Units

	 Information Tab
Displays the start time, end time, trigger time*, interval (sec), data size, data type, file 

name, path name, and host name.
	 * (If the data has no trigger point, the first data is used.)

	 Comment Information Tab
	 Displays the title and tag comment. Displays all comments.   The item is blank if the 

data contains no comments.
	 Batch Information Tab

	 Displays the batch information. The items are blank if the data contains no batch 
information.  The displayed items are application, supervisor, manager, batch 
name, lot number, comment user, comment time, and comments 1 through 3 (for 
details, see the user’s manual of the instrument that saved the batch information.)

3.3  Settings in the Channel Setup Screens
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3.4	 Displaying Trends

Displays waveforms according to the settings in the channel setup screens. 

Procedure
1.	 Click the Show the trend display button in either of the channel setup screens. 

The channels selected in the tab are loaded.  While loading, the “Receiving”dialog 
box is displayed, and when complete, the waveforms appear (click the Cancel 
button to stop the loading process. Only the waveforms of channels completely 
loaded at the point the Cancel button was clicked are displayed.  To load the 
remaining waveforms, click the “Get data for all channels”button).

	 Grid color
adjusutment
slider

Zone size
bar

Group
selection
tab

Waveform display 
button

Reacquire channel data button

Y-axis button

Active Y-axis 
mark

Background
adjustment
slider

Zone display
area

Zone display barShow/hide
waveform button

Time axis display 
area

Time axis
magnification

Alarm display
area

Waveform display area

Cursor BCursor A

Trip point
display area

Y-axis display area

Mark display area

Note
If some channels are not displayed, check the following.
•	 That the host exists, and that it is running DataBrowser.
•	 That the files shown under File Name in the folder indicated by the path in the Channel 

Information dialog box exist.
•	 That the network is connected correctly, and that no problems occurred on the network.
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Explanation
Group Selection Tabs
	 Click a tab to display the group. The name displayed is the one specified in the 

channel setup screen.
Waveform Display Area
	 The area in which the waveforms are displayed.  Displays waveforms according to the 

settings in the channel setup screens.  Click in the waveform display area to display a 
cursor.  Drag the cursor to display a second cursor.  Cursor A appears at the position 
where you first clicked; Cursor B appears at the position where you released the 
mouse button. (See section 3.5, “Displaying Cursor Values.”)

Alarm Display Area
	 The area in which the alarms are displayed.  Toggle the display using the Alarm ON/

OFF button on the toolbar.
Y-Axis Display Area
	 The area in which the Y-axes are displayed.  The Y-axes are shown in the specified 

colors.  If the trend display is user zone, edit zone, full zone, or slide zone, only the 
Y-axis of the active channel is displayed.  For auto zone or multi-zone, all channels 
are displayed.

Time Axis Display Area
	 The area in which the time axis is displayed.  You can select the display range using 

the scroll bar.
	 Toggle the display between absolute time and relative time display using the button on 

the toolbar.

			 

Zone Display Area
	 The area in which the display status of each channel can be changed.
	 Active Y-Axis Mark

	 The channel with this mark is the active channel.  The waveform and alarm data of 
the active channel are displayed in front.

	 Grid Color Adjustment Slider
	 Drag the slider up and down to adjust the grid color between white and black.

	 Background Adjustment Slider
	 Drag the slider up and down to adjust the background color between white and 

black.
	 Y-axis button

	 Each channel has its own color-coded button.  Click a button to make its channel 
active.  The active Y-axis mark moves to the top of the clicked button.

	 Zone Display Bar
	 Click to show or hide the zone display area.

	 Zone Size Bar
	 Drag to change the width of the zone display area.

	 Show/Hide Waveform Buttons
	 Click to show or hide channels.  These buttons mirror the waveform display ON/

OFF buttons in the channel display configuration screen.
Trip Point Display Area
	 Displays trip points.
Mark Display Area
	 Displays marks. All marks of the channels registered to the displayed groups are 

displayed.  Up to one thousand marks per channel can be displayed, and they can be 
added, edited, or deleted here. When marks are displayed on top of one another, the 
mark of the active channel is displayed in front.

3.4  Displaying Trends
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Time Axis Display Area
•	 The time display shows the time of the channel.   When the time reference mode 

is Start Reference, Trigger Reference, or End Reference, the time of the active 
channel is displayed.

•	 The time display shows the time relative to the start of the waveform display area.
Showing Channel Details
	 In the Trend display screen, the information of the active channel is displayed.

Displaying Waveforms of Different Intervals
Data of differing measurement intervals can be displayed in the same waveform display 
screen.
Measurement Interval of Displayed Waveforms
	 When the measurement intervals differ, the greatest common factor of the 

measurement intervals of the channels assigned to the displayed groups is used as 
the minimum interval unit for displaying all of the waveforms.  In the figure below, 
since the intervals for the three channels are 1 s, 500 ms, and 250 ms respectively, 
250 ms is used as the interval when all channels are displayed together.

			 

1s

500ms

250ms

250msGreatest
common
factor

Displaying Waveforms of Intervals Greater Than the Minimum Unit
	 If a channel’s interval is longer than the minimum unit interval, data values that are not 

measured points are displayed at the value of the points directly thereafter.

			 

Measured point

Measured point

Same value
Same value

Same value Same valueLonger than the minimum unit 
interval waveform

Minimum unit interval waveform

Minimum unit display interval
Measured point

	 The figure below shows a 100 ms and 1 s interval waveform. The waveform with the 
long interval is displayed in stages.

			 

Minimum Unit Interval for Linked Groups
	 The greatest common factor of the measurement interval of all channels registered to 

all groups belonging to the linked group is used as the minimum unit interval.

3.4  Displaying Trends
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Time Reference Mode
There are four time reference modes: Start Reference, Trigger Reference, End 
Reference, and Time Reference.
Start Reference
	 Waveforms are displayed using the first data of the channels assigned to the group as 

a reference.
Trigger Reference
	 Waveforms are displayed using the trigger point of the channels assigned to the group 

as a reference.
End Reference
	 Waveforms are displayed using the last data of the channels assigned to the group as 

a reference.
Time Reference
	 Waveforms are displayed using the measurement time of the channels assigned to 

the group as a reference.

			 
Time reference

Time

Time

: Trigger point

Start reference

Time

End reference

Time

Trigger reference

Save Format of Displayed Data
Data files are saved in two formats: one for waveform display and one for the cursor 
value dialog box.  Data saved in different formats can be displayed in the same Trend 
display screen.
The format in which one data is saved per unit of time is called Normal format, and the 
format in which two data—a minimum and maximum value—are saved per unit of time is 
called MinMax format.
The following shows the correspondence between data types and save formats.
Data Type Normal Format MinMax Format
DX100 Yes Yes
MV100/MV200 Yes Yes
CX1000/CX2000 Yes Yes
FX100 Yes Yes
MX100 Yes No
DAQLOGGER Yes No
AddMulti Yes No
AddTrigger Yes No

Note
Instruments that can save in MinMax format such as the DX100/200, MV100/200, 
CX1000/2000, and FX100 save data in two formats called Event data and Display data format.  
Event data is saved in Normal format, and Display data is saved in MinMax format. For details, 
see the user’s manual for your particular instrument.

3.4  Displaying Trends
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Waveform Display in Normal Format indstop and indstart MinMax Format
	 In Normal format, waveforms are displayed in the position corresponding to the data 

value at that time.
	 In MinMax format, waveforms are displayed as a fill between the two points 

corresponding to the Min and Max values at that time. When the Min and Max values 
are the same, items are displayed as if in Normal format.  If the difference between 
the Min and Max values is large, the thickness of the trace increases.

Intersection between Waveform and Cursor
	 In Normal format, the intersection is marked with a circle.
	 In MinMax format, the two intersecting points of the Min and Max values are enclosed 

by an ellipse.

			   Circle

Normal Format MinMax Format

Ellipse

Maximum value
Minmum value

Displaying Alarms
You can show or hide the alarm display area using the Alarm ON/OFF button on the 
toolbar. This operation mirrors the alarm ON/OFF operation in the Cursor Value dialog 
box.  Up to four alarm levels per channel are allowed.  As shown in the figure below, the 
alarm levels are 1, 2, 3, and 4, starting from the top level.  The colors of channels on 
which alarms occurred indicate the period of occurrence.   If multiple alarms occur at the 
same time, the alarm of the active channel is displayed in front.

			 

Alarm level 1
Alarm level 2
Alarm level 3
Alarm level 4

Y-Axis Display
There are six formats for the Y-axis: user zone, edit zone, full zone, slide zone, auto zone 
and multi-zone.   You can switch between them using the toolbar.
User Zone
	 The waveform of each channel is displayed in the position specified under Zone in the 

channel display configure screen. A single Y-axis of the active waveform is displayed.

			 

Displays the Y-axis of 
the active channel

Click a Y-axis of 
the active channel

Active Y-axis mark

3.4  Displaying Trends
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Edit Zone
	 The waveform of each channel is displayed in the position specified under Zone in the 

Channel Display Configuration Screen. You can edit the waveform display range by 
manipulating the Y-axis buttons in the zone display area.  Move the waveform position 
by dragging the Y-axis button up and down.  The waveform zone settings implemented 
here are reflected in the Zone setting in the Channel display configuration screen, as 
well as the user zone and multi-zone settings.   A single Y-axis of the active waveform 
is displayed.

			 

Displays the Y-axis of 
the active channel

Active Y-axis mark

Drag the knob to 
change the 
minimum/maximum
value of the zones 
individually

By dragging the zone 
you can change its 
position without 
changeing the range

Full Zone
	 Displays all the waveforms over the full zone of the waveform display area regardless 

of the Zone settings on the Channel display configuration screen. A single Y-axis of 
the active waveform is displayed.

			 

Displays the Y-axis of 
the active channel

Waveform display area (full zone)

Active Y-axis mark

Slide Zone
	 Displays the waveforms by slightly offsetting the display position of each waveform 

vertically regardless of the Zone settings in the Channel display configuration screen. 
A single Y-axis of the active waveform is displayed.

			 
The waveform of each channel are 
offset in this manner

Active Y-axis mark

3.4  Displaying Trends
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Auto Zone
	 Displays the waveforms by dividing the waveform display area evenly according to 

the number of displayed waveforms regardless of the Zone settings in the Channel 
display configuration screen.

			 
Automatically displays
the waveformin equal divisions

Active Y-axis mark

Multi-Zone
	 Arranges all the Y-axes from left to right, displaying all specified Y-axes.   Y-axes not 

selected in the Channel display configuration screen are not displayed.  The display 
range is set using the Zone parameter in the Channel display configuration screen. 
When you drag a Y-axis button onto the Y-axis display area, the Y-axis of the relevant 
channel is displayed. Conversely, if you drag a Y-axis onto the zone display area, the 
Y-axis of the relevant channel is hidden.

			 
The Y-axis of the active 
channel is displayed on 
the far right

Active Y-axis mark

If you drag the Y-axis display onto 
the zone display area, the Y-axis is hidden

Drag the Y-axis button of the Y-axis that is 
not displayed onto the Y-axis display area 
to display it again

Clip Function
Turning ON the clip function forces displayed points on the waveform that fall outside of 
the scale range to revert to the max. or min. value of scale.  Use the Clip button on the 
toolbar to turn the clip function ON and OFF.

			 

Clip OFF (initial setting) Clip ON

3.4  Displaying Trends
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Trip Point
The trip points are displayed according to the Trip 1 and Trip 2 settings in the Channel 
display configuration screen.  You can drag the trip 1 and trip 2 displays to change 
them.  These changes are reflected in the Trip 1 and Trip 2 items in the Channel display 
configuration screen.

			 

Trip 1

You can change the trip point by dragging

Trip 2

Copying the Trend Display
Clicking the XX button (copy button) in the Trend display toolbar copies the displayed 
trend screen.   You can paste the copied screen onto a standard “Paint”program that 
comes with your operating system.

			 

3.4  Displaying Trends
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3.5	 Displaying Cursor Values

Procedure
1.	 In the waveform display, click the group from which you wish to read values using 

cursors.

2.	 Click the position in the waveform display area where you wish to read the data. 
If you wish to read another point at the same time, drag the cursor. Cursor A 
appears at the position where you first clicked; Cursor B appears at the position 
where you released the mouse button. The measurement point is displayed where 
the waveform and the cursor cross using a yellow circle.

					   

Cursor A

Cursor B

3.	 Click the Display Cursor Rearout button on the toolbar. The Cursor Readout 
dialog box opens.

			 

Alarm indication
Value of Cursor A Value of Cursor B-A

Value of Cursor B Time of Cursor A
Time of Cursor B

Move
Cursor A Move Cursor B

Data number at the 
Cursor A position

Data number at the Cursor B position

Difference in the data 
number between 
Cursor A and B

Channel display
color

Active channel mark

Explanation
The data at the currently displayed cursors are displayed.
Data No.
	 Displays the data number at the Cursor A and B positions.
Time Difference
	 Displays the time difference between cursors A and B.
Relative Time
	 Displays the time using the first data of the displayed range between cursors A and B 

as a reference.
Value A and Value B
	 Displays the values and alarms of each channel at cursor A or cursor B.   Changes to 

red if an alarm occurred, and green if an alarm did not occur. The value is blank if no 
data exists at the cursor position.

Value B-A
	 Displays the result of subtracting the values at cursor A from those at cursor B.
Time A and Time B
	 Displays the time at cursors A and B.
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Normal and MinMax Format Display
	 Values of channels In Normal format are displayed in a single row.   Values of 

channels in MinMax format are displayed in two rows, one for the minimum and 
maximum value at the cursor position.

Switching the Active Channel
	 You can switch the active channel. The active channel mark is displayed between the 

waveform number and its color. Click the box of the channel you wish to make active.  
This changes the active channel in the trend display screen as well.

Moving Cursors
	 You can move the cursor positions on the trend display using the Up and Down 

buttons.

Note
•	 The cursors used to display cursor values and those used to specify the interval for 

statistical computation over an area are the same.
•	 The Cursor Readout dialog box and opens. The Computation Results dialog box can be 

displayed at the same time.
•	 If you click a different group in the Trend display screen with the Cursor Readout dialog box 

open, the Cursor Readout dialog box displays the cursor values of the selected group.
•	 You can change the cursor positions in the trend display screen while the Cursor Readout 

dialog box is open.

Deleting Cursors
Click the  button (Erase Cursor button) on the Trend display toolbar. The cursors are 
cleared as well as the cursor values displayed in the Cursor Readout dialog box.

3.5  Displaying Cursor Values
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3.6	 Displaying Computed Results (Statistics)

Procedure
1.	 In the waveform display screen, click the tab of the group on which you wish to 

perform statistical computation over an area.

2.	 Click the start point of the computation area in the waveform display area, then 
drag the cursor to define the area and end point (use the cursor in the same 
manner as in section 3.5, ìDisplaying Cursor Values.”

3.	 Click the Statistics button on the toolbar. The Statistics dialog box opens.

Channel display
color

Progress bar

Explanation
Specify using two cursors the interval over which computation is to be performed. 
If the cursors are not displayed, all the data are used in the statistical computation. 
The statistical parameters are the minimum value, the maximum value, the P-P value 
(maximum - minimum), the mean value, and the rms value. The computation is executed 
when the dialog box is displayed, or when you click the Calculate button.
(Channels in Normal format are displayed in a single row.   Values of channels in MinMax 
format are displayed in two rows, one for the minimum and maximum value at the cursor 
position.  )
Min and Max
	 Shows the maximum and minimum values of the range selected by the cursors, or the 

entire range.
PP
	 Shows the difference between the maximum and minimum values of the range 

selected by the cursors, or the entire range.
Mean
	 Shows the mean values of the range selected by the cursors, or the entire range.
RMS 
	 Shows the RMS values of the range selected by the cursors, or the entire range.
Start Time and End Time
	 Shows the start and end times for computation for each channel.
Progress Bar
	 Displays the execution status of the computation.
Calculate button
	 Recalculates the statistics.   If you change the positions of cursors while the Statistics 

dialog box is open, click this button to refresh the computed results.

Note
•	 The cursors used to display cursor values and those used to specify the interval for 

statistical computation over an area are the same.
•	 The Statistics dialog box and Cursor Value dialog box can be displayed at the same time.
•	 The statistical results are not linked to cursor movements or switching of groups.  After any 

such changes are made, click the Statistics button or the Calculate button to recalculate and 
display the results.
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3.7	 Saving and Loading Trend Settings

Saving Data Trend Settings
Procedure

1.	 Click  (the Save button) in the DataBrowser window or choose File > Save 
current trend configuration as  from the menu bar. The Save the trend settings 
dialog box appears.

					   

Drag to change the column width

Update button

Delete button

2.	 Enter a file name and comment and click the Save button.

	  The currently displayed trend settings are saved.

Explanation
File List
	 Displays the trend settings file name and comments saved on the local host.
Delete the selected file button
	 Deletes the selected trend settings file.
Update button
	 Updates the trend settings file list.
File Name
	 Enter the name of the file you wish to save (an extension is automatically added).
Comment
	 Enter comments to be saved with the file.  Up to 255 alphanumeric characters can be 

entered.
Save button
	 Saves the settings file under the specified file name on the local host.

Note
After saving a trend settings file, the saved file name and comment appears in the text box the 
next time you open the Save the trend settings dialog box (these items are blank if no settings 
have been saved previously, or when starting up the software).  Also, when you select a file in 
the Save the trend settings dialog box, the file and comment are displayed in the input boxes at 
the bottom of the window.  This allows you to conveniently overwrite settings.
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Opening Trend Settings from a Local Host
Procedure

1.	 Click  (the Open button) in the DataBrowser window or choose File> Open  
from the menu bar. The Open dialog box is displayed.

					   

Drag to change the column width

Double-click a number to open the file

Update button

Delete button

2.	 Select a file and click Open, or double-click the file number. The Information 
dialog box opens.

					   

3.	 Click the Yes button. The trend settings loaded from the trend settings file are 
displayed.  Click No to close the Information dialog box.

Explanation
File List
	 Displays the name of the settings file and comments saved on the local host.
Delete the selected file button
	 Deletes the selected file.
Update button
	 Updates the displayed file list.
File Type
	 If you select all files (.dbc; .dbv), the saved search settings files and display settings 

files are displayed.
	 If you select Search settings file (.dbc), only the search settings files are displayed.
	 If you select Trend settings file (.dbv), only the display settings files are displayed.
Open button
	 Opens the settings file selected in the File List.  (When a trend settings file is opened, 

the Trend display window becomes active.) When a search settings file is opened, the 
Search window becomes active.

Cancel button
	 Closes the Open dialog box.

3.7  Saving and Loading Trend Settings
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Opening Trend Settings indstop from a Network Host
Procedure

1.	 Click  on the toolbar or choose File> Open  from the menu bar. The Open 
dialog box is displayed.

2.	 Click the Hosts on network tab. The Hosts on network tab is displayed.

3.	 Click the Update button. The names of hosts running DataBrowser, and their 
corresponding files names and comments are displayed.

					     Drag to change the column width

Double-click a number to open the file

Update button

4.	 Select a host from the Host List.   The a list of files saved on the selected host is 
displayed.

5.	 Select a file from the list that you wish to load and click Open, or double-click the 
file number. The Information dialog box opens.

					   

6.	 Click the Yes button. The trend settings loaded from the trend settings file are 
displayed.  Click No to close the Information dialog box.

Explanation
Host List
	 The Host List displays the names of any hosts on the network that are running 

DataBrowser.
File List
	 Displays the settings files and comments saved on the host selected in the host list.
Host Name
	 Displays the name of the host selected in the host list.
Update button
	 Updates the host list and file list.
File Type, Open Button, and Cancel Button
	 See Opening Trend Settings Files from a Local Host.

3.7  Saving and Loading Trend Settings
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3.8	 Converting Data Formats

Procedure
1.	 Open the waveform display screen and display the waveforms of the data you 

wish to convert.

2.	 Select a range to convert using the cursors (if no cursors are displayed all data 
will be converted).  Click  in the waveform display screen toolbar. The Data 
Conversion dialog box opens.

					   

Select the check box of 
the desired conversion 
type to turn it ON

3.	 Select a conversion type of Excel, Text, or Lotus.   To change the range of data to 
be converted, specify a Start and End point.

4.	 Enter the number of steps.  (See Explanation for details.)

5.	 To select a channel whose interval is to be used for the interval during data 
conversion, select the Write Measured point of the following channel check box 
and click the Select button.  The Selection dialog box opens. (See Explanation for 
details.)

Select the channel for output of measured points

6.	 If you click channel whose measured points are output, that channel is displayed 
in the Data Conversion dialog box.

7.	 Click the File button. The File name dialog box opens.
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8.	 Enter a destination folder and file name and click the OK button.

	 The name of the output file appears in the Data Conversion dialog box.

9.	 Click the Start button.

					   

Explanation
Conversion Type
	 Excel

	 Data that can be opened using Microsoft’s spreadsheet application Excel version 4.0 
or later. The extension is .xls.

	 Text
	 Text data with each data point separated by a comma. The extension is .txt.

	 Lotus
	 Data that can be opened using Lotus”spreadsheet application 1-2-3 version 2.0 or 

later. The extension is .wj2.
Start and End Points
	 You can select a range of data to convert. If cursors are placed in the trend display 

screen, the range determined by the cursors defines the start and end points.  If no 
cursors are displayed, all the first and last data of all the data represent the start and 
end points.   Also, the start and end times are displayed to the right of the entry boxes. 

Step Setting
	 You can specify an interval for data conversion output. This area includes the setting 

for the number of steps, and a setting for specifying the channel whose measured 
points are to be output (Write Measured point of the following channel).
•	 If the Write Measured point of the following channel check box is not selected, the 

measured points of all channels assigned to the group are output, and the smallest 
unit interval is used as the reference interval.

•	 If the Write Measured point of the following channel check box is selected, the 
interval of the selected channel is used as the reference interval.

•	 By specifying the number of steps, rather than outputting all points in the range 
(steps = 1), you can thin the data by outputting only the points sampled at certain 
intervals.

3.8  Converting Data Formats
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	 The figure below shows an example of output when the Write Measured point of 
the following channel check box is not selected, the smallest unit interval (reference 
interval) is 0.5 s, and the number of steps is 1 (if the steps were set to 3, samples 
would be output every 1.5 s).

		

CH01(1.5s)

Minimum unit interval
(0.5s)

CH02(0.5s)
CH03(1.0s)
CH04(2.0s)
CH05(1.5s)

: Measurement point of each channelOutput (0.5 s)
The squares represent the output of measured points on each channel (0.5 s) 
If the Write Measured points of the followimg channel check box is selected 
and channel 3 is also selected, measured points on each channel are output 
every 1 s.

Note
•	 If the output points are not measured points, the points directly after are output.
•	 When the Write Measured point of the following channel check box is selected, the start and 

end times on the right are those of the selected channel.

Example of the Converted Data

		

Notes When Converting Data
•	 There is a limit to the number of data points that Excel and Lotus1-2-3 can handle. 

Before executing the conversion, set the channels/groups to be converted, the 
conversion range, and the step so that the number of data points is appropriate (see 
Automatic Division Function for Conversion Output Files).  In addition, if the free 
memory space on the PC is low, you may not be able to load the data using Excel or 
Lotus 1-2-3.

•	 If you set the save destination to a storage medium that has slow access such as a 
floppy disk, the saving of the data may take an extended time. It is recommended that 
such storage medium not be selected for the save destination.

•	 Select a save destination with adequate free space.

3.8  Converting Data Formats
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Automatic Division Function for Conversion Output Files
	 If the number of points to be converted and output is large and you attempt to save all 

the points to a single file, the file will exceed the allowable number of rows in Excel or 
Lotus 1-2-3, making the file unloadable.

	 The Automatic Division function automatically creates multiple files that are within the 
row number limit of Excel and Lotus 1-2-3.  The names of the divided files are the 
original file name plus an appended sequence number.
	 File name format: file name-****.extension (where **** is a four-digit number).

	 Ex. Output-0003.xls
	 Excel row limit: 65536
	 Lotus 1-2-3 row limit: 8192

	 Automatic division is not available for conversion to text format.

3.8  Converting Data Formats
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3.9	 Printing Data

Printing
Procedure

1.	 Open the waveform display screen.

2.	 Click  (the Print button) on the toolbar or choose File > Print from the menu 
bar. The Printout settings dialog box opens.

					   

Enter a comment 
to be printed
(of up to 255 alphanumeric 
characters)

3.	 Select a print range and color, and enter a print title.   Click the OK button. The 
Print dialog box opens.

					   

4.	 Click the OK button.

Viewing a Print Preview
Procedure

1.	 Open the trend display screen.

2.	 Choose File > Print Preview from the menu bar.
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Explanation
You can print cursor values and statistics along with waveforms from the trend display 
screen.   To print cursor values and waveforms, open the Cursor Value dialog box before 
printing. To print statistics, open the Statistics dialog box before printing.  To print cursor 
values and statistics, open both dialog boxes before printing.
Print Range
	 Choose from Between Cursors and All.  Selecting Between Cursors prints the 

waveforms in the cursor range displayed on the trend display screen on a single page. 
Specifying Colors
	 You can select black/white print or color print.
Print Title
	 Enter a title to be printed at the top of the paper.

3.9  Printing Data
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Chapter 4	 Troubleshooting

4.1	 Error Messages and Corrective Actions

A message (such as an error message) may appear during operation. The following 
describes the meanings of the messages and their corrective actions.

Code Description Corrective Action
E0002 Insufficient memory. Please close at once. Exit all other software programs and restart the OS.
E0004 Invalid license number. Reinstall the software.

Please reinstall.
E0101 Please open from the DataBrowser.  This software cannot be opened by itself.

Start it from the DataBrowser.
E4948 Could not initialize communications.   Check whether TCP/IP is operating normally.
M4959 Cannot exit while DataBrowser is starting up.  Close DataBrowser, then shut down or log off.

Search Folder Registration
Code Description Corrective Action
E4925 No more search folders can be registered. The limit of eight folders that can be registered in the 

search folder registration area has been reached.  If 
you need to register a new folder, first delete one or 
more of the folders first.

E4940 Same folder ID already exists.
Check the list of registered folders.

A folder with the same ID has already be registered 
in the search folder registration dialog box.   Either 
delete the existing folder from the list, or register the 
new folder using a different ID.

E4957 Same folder ID already exists.
Check the search folders.

Same folder ID already exists in the search folder 
registration area.   Therefore, the new one cannot be 
registered.  Delete the folder with the same ID from 
the registration area, or, register the new folder using 
a different ID.  If registering with a different ID, use a 
folder ID not already listed in the registration area.

E4960 Limit of folders that can be registered exceeded. If more than two hundred folders would be registered, 
registration is denied.  If you need to register a new 
folder, first delete an existing one from the folder 
registration list in the search folder registration dialog 
box.

Executing Searches
Code Description Corrective Action
E4907 No response.  Check whether the network is connected correctly 

(cables, hubs, and other hardware), and that no 
problems occurred on the network.

E4939 Folder ID not found. On the host on which the error occured, the search 
could not be performed because the folder ID does 
not exist in the folder registration of the DataBrowser 
being run.  Register the search folder on the 
DataBrowser on the host on which an error occured.

E4942 Folder not found. Check whether the folder exists on the DataBrowser 
on the host on which an error occured.

E4945 Failed to write file. Failed to write the search results file. Confirm that the 
disc capacity and file system are correct.

E4946 Connection failure. Check whether the host on which an error occured 
exists.  If it exists, check whether DataBrowser is 
running on that host.
Check whether the network is connected correctly 
(cables, hubs, and other hardware), and that no 
problems occurred on the network.
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Code Description Corrective Action
E4947 DataBrowser not found. Software may be running on the same port (50285) 

used by DataBrowser.  Check the host on which the 
error occured.

E4956 The number of data files that meet the criterion 
exceeded the limit.

If the number of data files that meet the search 
the upper limit of 60000, narrow down your search 
conditions and perform the search again.

Saving and Loading Settings and Search Results
Code Description Corrective Action
E0211 Cannot write to the file. Failed to save the file. Confirm that the disc capacity 

and file system are correct.
E0212 Cannot read file. Confirm that a file exists, that the software supports it, 

and whether the file system is correct.
E0213 Cannot open the file. Confirm that a file exists, that the software supports it, 

and whether the file system is correct.
E4955 Failed to delete file. When files were deleted, one or more files could not 

be completely deleted.
M4959 No search results. Since no search results files are in the data search 

window, search results could not be saved.

Saving and Loading Settings and Search Results
Code Description Corrective Action
E4961 Failed to copy data file. Failed to copy data file.  Check whether the disk 

capacity in the copy destination is sufficient, whether 
the copy destination folder is write-protected, and 
whether the file system is correct.

E4962 The copied data file exists under a different name. A data file of the same name was found in the copy 
destination.  Change the name.  In this case, save 
the file in the copy destination under the name, “copied 
file name-four digit number.extension.”  The four digit 
number starts with 0000, followed by 0001, and so 
on.

4.1  Error Messages and Corrective Actions
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